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Introduction  

The HDX module analyzes mass spectrometry data acquired from hydrogen-deuterium exchange 
experiments. HDX is available as a standard workflow in Byos®. 

General Notes 

• MS data should be located on the local computer (not on a network drive) and should not be in 
read-only folders, because Byos writes cache files during project creation. 

• Projects created with beta versions of the HDX software may not open properly. Beta version 
projects should be re-created. 

• Processing Waters .raw data (including data collected with ion mobility) is now fully supported. 

• If the *.blgc project is copied to another computer, it is best to also copy the data files/folders and 
cache files to the new computer. 

Creating a Project  

To create a new project, go to the Byos Workflows tab and click the HDX workflow icon:  

 

Figure 1: The Byos workflows with the HDX icon highlighted 
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A multi-tab workflow (e.g., Samples, Sequences and Processing nodes tabs) window allows the 
analyst to designate one or multiple mass spectrometer files to be analyzed, each with one or multiple set 
of MS/MS search results and other parameters, as well as a corresponding set of protein sequences. 

 

Figure 2: HDX workflow showing Samples tab 

Samples Tab  

The Samples tab allows the user to load raw LC-MS sample files into the project. Drag-and-drop MS data 
onto the Samples table. The order of files is important. Data for the reference condition should be 
added first. (Note that the Sample type, which can be “Reference” or “NonReference” is ignored). 

Tip — If dragging-and-dropping multiple MS data files/folders simultaneously, it is usually best to place 
the mouse pointer at the top of your list of MS data files/folders. For example, during drag-and-drop of 
these four files (e.g., file1.raw, file2.raw, file3.raw and file4.raw), if the mouse pointer is over the top file 
i.e., file1.raw, then the Samples table will also have file1.raw at the top: 

 

Figure 3: Drag-and-drop from the top file to maintain sample order 

If the mouse pointer is not over the top file, then the file that the mouse is over will be on top. For 
example, if it is over file3.raw — then the Samples table will have file3.raw at the top. 

To load files by browsing for them, click the Add sample button, double-click on the new row under the 

MS file header, click   and browse to the file. Click Open.  
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Sample table Columns 

Make sure to fill in the Condition and Exchange Time columns. The others are auto-filled or optional. 

• Sample name: defaults to the file name. To change the Sample name, double-click the name 
and edit the text. The name can also be updated later in the Project table.  

• MS/MS Search: To add an incremental MS/MS search result to a sample, double-click in that 

sample row under the MS/MS Search header, click  and browse to the MS/MS search result 
(*.byrslt or *.dat) file. Click Open. To attach additional Ms2 search result to that sample, click  to 
add a new MS/MS Search row and repeat the addition steps.  

To remove an MS/MS search file, double-click the file name and click , 

• Digestion: This column is not used for HDX projects. 

• Condition: Different conditions in the HDX experiment should be assigned different labels (for 
example, “Apo,” “Holo,” etc.). In the plots (XIC plots, Isotope plots, Uptake plot), each condition is 
assigned a unique color. The reference condition should be listed first. Note that the reference 
condition cannot be changed after project creation. 

• ExchangeTime: Fill in the exchange time as a number (for example, “30,” not “30 sec”). 
ExchangeTime for all samples should have same units (i.e., “3600”, not “1 hr”, if rest of samples 
are in seconds). 

• Replicate: Optional. Must be an integer number. Can be useful for filtering the data when 
inspecting the project. For example, this can reduce clutter on the screen by restricting the results 
to a single replicate. 

Tip — To fill in multiple cells simultaneously: Select multiple rows using shift-left-mouse-click or 
control-left-mouse-click. In the column of interest, right-mouse-click and select Edit selected 
row(s), select or enter the value, and click OK. 

An example of a completed Samples tab is shown below: 

 

Figure 4: Completed Samples tab 
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Sequences Tab  

The Sequences tab allows the user to enter a protein sequence either by adding a FASTA file or by 
typing it in directly:  

 

Figure 5: Sequences tab 

To add a *.fasta or *.fa file, click Browse for FASTA file, locate the file to be added and click Open. 
FASTA files also can be dragged into this dialog directly. An example of a sequence added from a 
FASTA file is shown below: 

 

Figure 6: Sequences tab with protein added from a FASTA file 

Processing nodes Tab 

The Processing nodes tab is where the user sets experimental parameters.  
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Figure 7: Processing nodes tab 

The left side of the Processing nodes tab holds parameters for the MS/MS database search for peptide 
identification. The right side holds parameters for the % deuteration analysis of the MS¹ data. Most of 
these parameters are described in 02 PMI Byos Manual.pdf in the PTM > Processing nodes section. A 
few parameters are critical to HDX.  

 

Figure 8: Critical HDX parameters marked in gold, instrument-specific parameters marked in green 

Critical Parameters 

The parameters that are required for HDX workflows are highlighted in gold in the figure above: 

• Samples: Specify a text pattern that matches the undeuterated MS/MS data to be used for 
database search but does not match the MS¹ data. For example, ”*mapping*“ can be used if all 
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of the undeuterated MS/MS data contain “mapping” in their file names but none of the MS¹ data 
of the deuterated samples contain “mapping” in their file names. (Note: Edit the sample file 
names to fit to this criterion before running the HDX workflow) 

• Mass tolerances and fragmentation type: Choose appropriate settings for the data. 

• Time tolerances: If the run-to-run chromatography is highly reproducible, the retention time 
tolerance can be decreased. 

Parameters Specific to Instruments 

The following three lock mass parameters (highlighted in green in the figure above) should be set for 
specific instruments (e.g. Waters): 

• Recalibration (lock mass) 

• Enable Lock-Mass Calibration 

• Lock Mass (m/z) 

Predefined Peptides Without Byonic Database Search 

For predefined peptides (i.e., in-silico peptide list), the left side of the Processing nodes tab should be 
deleted (i.e., the Byonic search), and an in-silico peptides CSV should be specified. For an example file 
showing the format, see C:\Program Files\ProteinMetrics\PMI-

Suite\ExampleData\ImportExample.Byologic.csv. 

To remove the Byonic search from the Processing nodes tab, right-click in the MS/MS Ids (Byonic) 
header and click Remove: 

 

Figure 9: Removing the Byonic Processing nodes 

To add an in-silico peptides CSV file, expand In-silico options (CSV Import), click in the In-silico 
peptides CSV cell, click the “…” button, navigate to and select the CSV file, and click Open. 
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Figure 10: In-silico CSV file selection 

Save Workflow and Create Project 

The customized workflow can be used as a template for future HDX runs. To save the workflow, click the 
Save Workflow button, assign a custom workflow name, and click Save. 

To generate the project, click Create Project, assign a project name, and click Save. 

Project Inspection 

An example of a completed project is shown below: 

 

Figure 11: HDX project 

A good column sort can greatly facilitate inspection. Click on the column headers of the Peptides 
table in the reverse order from the field sort priorities. For example, to generate the following sort: 

• Start AA 
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• End AA 

• Condition 

• ExchangeTime 

then click on ExchangeTime, Condition, End AA, and Start AA, in that order. 

Other columns that may be helpful to sort/filter are XIC area summed and PEP 2D. 

The XIC plots, Isotope plots and Uptake plot all contain the Sync filtering and sorting icon . When 
the icon is active in the plots, the plots apply the same filtering and sort orders set in the Peptides table 

for the selected record by clicking the  filter icon: 

 

Figure 12: Example filter applied to Peptides table records 

By default, the Peptides table filtering is synced to all the plots: 

 

Figure 13: Synced filtered plots 

To un-sync the filtered plots, de-select the sync button (shown in the orange boxes above). 

Uptake Plot 

Uptake plots estimate the percent deuterium uptake of each selected peptide: 
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Figure 14: Uptake plot 

“100% Deuteration" is defined by the number of amino acids in the peptide, minus the number of proline 
residues, minus 2 (for fast back-exchanging N-term residues). 

When a project is first opened, the Uptake plot’s default y-axis range is -15% – 115%. After performing 
any zoom operations on the Uptake plot (e.g., zoom in, zoom out, pan, reset zoom), the default zoom can 
be restored using advanced commands, as described below. 

The behavior of the Reset zoom button (1:1 button) can be altered with an advanced command that fixes 
the y-axis range. For example, if you use the following advanced command: 

[XY] 

YRange = 0,50 

 
and then you press the Reset zoom button (1:1 button), the plot’s y-axis range becomes 0 – 50. 

To restore the default y-axis range (i.e., the y-axis range when you first opened the project), use the 
following advanced command: 

[XY] 

YRange = -15,115 

 
and then you press the Reset zoom button (1:1 button). To add an advanced command, choose Edit > 
Advanced configuration: 
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Figure 15: Advanced commands in the Advanced Configuration dialog 

The y-axis variable can be changed by clicking on the  icon. 

 

Figure 16: Changing the y-axis variable 

The x-axis variable cannot be changed (it is always ExchangeTime). Y-axis options include % 
deuteration, Center of m/z shift, or Center of mass shift. The Zoom options section controls the 
same zoom and scrolling options available for other plots. 
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Isotope Plots 

 

Figure 17: Isotope plots 

The magenta dotted lines show the center of m/z, and the dots on the peaks show the isotopes used to 
calculate the center of m/z. Show/hide of either of the magenta dotted line and/or the dots can be 

configured by clicking on the “  icon. 

 

Figure 18: Isotope plot Annotation settings 
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XIC Plots 

The XIC plots show the time range over which the center of m/z analysis was performed: 

 

Figure 19: XIC plots 

Curating Peptides 

Poor peptides can be excluded by marking them as false positives in the Peptide table’s Validate column 
(or by using the keyboard shortcut Ctrl+F). Then apply a filter to exclude all false positives. 

 

Figure 20: Marking a peptide as a false positive 
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Click the Search filter button and check False-positive under Show: 

 

Figure 21: Filtering out false positives 

Updating Plots With Custom XIC Time Range 

To change an XIC time window for a peptide of interest, select only that peptide row (e.g., peptide of a 
specific sample). In the Peptides table, expand the tree view and select a single peptide (the XIC plots 
pane as well as the Isotope plots pane should each display a single trace). Then, in the XIC plots pane, 
hold down the shift key and with the mouse key depressed, drag across the desired time window. A black 
horizontal bar will indicate the selected time range. 
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Figure 22: Selecting a new XIC time range 

Upon releasing the mouse button, the Isotope plot and the uptake plots will update to reflect the new time 
range selected in the XIC plot, as shown in the figure below: 

 

Figure 23: Updated plots to reflect new XIC time range 

The change is immediately saved to the project. Note that an uptake plot exists for “deuterated samples” 
only. NOTE: Instead of shift/drag option, the same mode can also be enabled by selecting Inspection 

mode icon  (this icon only appears after selecting a single peptide from a single sample from the tree 
view). When selected, Inspection mode allows the user to mark a range within a XIC plot to inspect the 
Isotope plots for that range. 



HDX User Guide v5.11                   

 

16 

 

To revert the change, click the Undo button or select Undo from the Edit menu (see figure below). 

 

Figure 24: Revert change with Undo button 

 

Figure 25: Revert change with Undo from Edit menu 

Reporting 

While the HDX project inspection view is designed for inspecting peptides in detail one at a time, the 
Report tab is designed to show information about all peptides in aggregate. The HDX workflow uses a 
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specialized report template designed for their unique features (the file is found in File > Presets > Report 
presets > Blgc_HDX.rptc). The report tabs include: 

• Protein Map – shows a peptide-level view 

• Heatmap  – shows a residue-level view  

• Protein 3D – If the protein’s 3D structure is known, the residue-level data can be overlaid onto 
the 3D structure  

• Uptake plots – shows all the plots (uptake plot, MS² plot, MS¹ plot, XIC plot) all at once, allowing 
for convenient export of all plots to PDF 

The reference condition is the first non-null condition in the MS data list (as specified during project 
creation). 

Protein Map Tab (Peptide-Level View) 

In the Protein map visualization, each horizontal line represents a peptide: 

 

Figure 26: Peptide-level protein map 

X-Axis 

The protein residue number and sequence are on the x-axis. For long sequences, the window should be 
made wider. 
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Figure 27: Resetting the chart width for long sequences 

Y-Axis 

By default, the y-axis shows the difference in % deuteration between two conditions averaged over all 
exchange times. % deuteration alternatives can be center of m/z shift or center of mass shift.  

Filtering 

The plot legend (or which Exchange time or conditions are visible) can be adjusted using the following 
user interface controls: 

• Exchange time 

• Condition 

 

Figure 28: User interface controls for adjusting the y-axis variable 

Visualization Types 

An alternative visualization to the Protein Map is the Bar Chart, where each bar represents a peptide, 
and the bars are ordered from N-terminus to C-terminus. Note that only the relative position of the bars is 
meaningful; the distance of the bar along the x-axis is not meaningful in the peptide-level view bar chart. 
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Figure 29: Peptide-level bar chart 

Heatmap Tab (Residue-Level View) 

 

Figure 30: Residue-level heatmap 

X-Axis 

Same as the peptide-level view. 
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Y-Axis 

Same as the peptide-level view, except the calculation is done for each residue by averaging over all the 
peptides that include that residue. 

Visualization Types 

The default visualization type is the heat map, but interesting alternative visualization types include the 
Bar Chart and the Line Chart. 

 

Figure 31: Residue-level bar chart 
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Figure 32: Residue-level line chart 

For the residue-level bar chart and line chart, it is best to enable the numeric X-axis. To do so, chose Edit 
> Current tab settings, and check Numeric X-axis. 

 

Figure 33: Numeric X-axis 

Protein 3D Tab 

 

Figure 34: Protein 3D structure (gray regions of 3D plot indicate values near 0, as shown in legend) 

The calculations and user interface controls for % deuteration alternatives, exchange time, and condition 
are identical to the residue-level view. 

A new 3D protein structure (PDB) file can be added by choosing Edit > Edit PDB in the main menu (see 
figure below) and selecting a PDB file from your local device: 
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Figure 35: Changing the PDB file 

Once a new PDB file has been added, click on Tabs > Update tab content in the Report menu to view 
the new PDB structure in the drop-down menu. 

To adjust the alignment, click Edit > Current tab settings > Add chain configuration (within Protein 3D 
settings) that opens a Add chain configuration pop-up dialog where Position offset field for the 
selected chain can be adjusted. 

 

Figure 36: Aligning Sequence to Protein 3D structure 

Uptake Plots Tab 

Uptake plots estimate the percent deuterium uptake of each peptide. Each colored dot represents a 
sample. Also provided are the MS², MS¹, and XIC plots. Options for plot rescaling and the order can be 
set using the Resize plots checkbox and Plot scaling %. 
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Figure 37: Plots 

Managing ExchangeTime and Condition Values 

The Include/Exclude checkboxes determine which exchange times or condition values are included (e.g., 
in the average), The Show/Hide checkboxes determine which columns are shown. 

 

Figure 38: Include/Exclude and Show/Hide for ExchangeTime 

Like the exchange times, one can filter on the conditions of interest. 
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Figure 39: Include/Exclude and Show/Hide for Condition 

 

 


